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FEATURES 
Full featured evaluation board for the 

AD7944/AD7985/AD7986 
Versatile analog signal conditioning circuitry 
On-board reference, reference buffers, and ADC drivers 
System demonstration board compatible (EVAL-SDP-CH1Z) 
PC software for control and data analysis of time and 

frequency domain  

EVALUATION KIT CONTENTS 
EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ 

evaluation board 

ADDITIONAL EQUIPMENT AND SOFTWARE 
System demonstration platform (EVAL-SDP-CH1Z) 
Precision source 
World-compatible, 12 V dc supply adapter  

(included with EVAL-SDP-CH1Z) 
Power supply, +7.5 V/−3.0 V (optional) 
USB cable 
SMA cable 

ONLINE RESOURCES 
Documents Needed 

AD7944, AD7985, and AD7986 data sheet 
EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/ 

EVAL-AD7986FMCZ user guide 
Required Software 

AD7944/AD7985/AD7986 evaluation software 
Design and Integration Files 

Schematics, layout files, bill of materials 

GENERAL DESCRIPTION 
The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/ 
EVAL-AD7986FMCZ are evaluation boards designed to 
demonstrate the low power performance of the AD7944/ 
AD7985/AD7986 14-/16-/18-bit, PulSAR® analog-to-digital 
converters (ADCs) and to provide an easy to understand 
interface for a variety of system applications. Full descriptions 
of the AD7944, AD7985, and AD7986 are available in the 
respective product data sheets, which should be consulted in 
conjunction with this user guide when using these evaluation 
boards.  

The user PC software controls the evaluation board over the USB 
cable through the Analog Devices, Inc., system demonstration 
platform (SDP) board, the EVAL-SDP-CH1Z.  

On-board components include the following: 

 The ADR3412/ADR4525/ADR4550 high precision, 
buffered band gap, 1.2 V/2.048 V/5.0 V reference options  

 The AD8031 reference buffer  
 The ADA4899-1/ADA4897-1/AD8021 signal conditioning 

circuit with three op amps and an option to use a 
differential amplifier (AD8139) 

 The ADP7118, ADM7160, ADP2370, and ADP7182 
regulators to derive necessary voltage levels on board 

The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/ 
EVAL-AD7986FMCZ evaluation boards interface to the  
EVAL-SDP-CH1Z SDP board via a 160-pin FMC connector. 
SMA connectors, JP1/JP4 and JP2/JP5, are provided for the 
low noise analog signal source. 
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Figure 1.  
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FUNCTIONAL BLOCK DIAGRAM 
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Figure 2.  
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EVALUATION BOARD HARDWARE 
DEVICE DESCRIPTION 
The AD7944 is a 14-bit, 2.5 MSPS successive approximation 
(SAR) ADC. The AD7985 is a 16-bit, 2.5 MSPS SAR ADC. The 
AD7986 is an 18-bit, 2 MSPS SAR ADC. 

These ADCs are low power and high speed and include an 
internal conversion clock, an internal reference (and buffer), 
error correction circuits, and a versatile serial interface port. On 
the rising edge of CNV, each ADC samples an analog input, IN+, 
between 0 V and REF with respect to the ground sense, IN−. 
The ADCs feature a very high sampling rate turbo mode 
(TURBO is high) and a reduced power normal mode (TURBO 
is low) for low power applications where the power is scaled 
with the throughput. 

Full descriptions of the AD7944, AD7985, and AD7986 are 
available in the respective product data sheets, which should be 
consulted in conjunction with this user guide when using the 
evaluation boards. Full details on the EVAL-SDP-CH1Z are 
available at the SDP board product page. 

HARDWARE LINK OPTIONS 
The default link settings and the functions of the link options 
are shown in Table 1. 

POWER SUPPLIES 
The power (12 V) for the EVAL-AD7944FMCZ/EVAL-
AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards comes 
through a 160-pin FMC connector, J7, from the EVAL-SDP-
CH1Z. The user also has the option of using an external 12 V 
supply to power the evaluation board. On-board regulators 
generate the required levels from the applied 12 V rail. The 
ADP7118 (U18) supplies 7.5 V for the +VS pin of the ADC 
driver amplifiers (ADA4899-1, ADA4897-1, or AD8021), the 
external reference ADR4550 (U5), the ADR4525 (U8), and the 
ADR3412. Another ADP7118 (U10) supplies 5 V for BVDD 
(U1), the ADP2370 (U2), and the ADM7160 (U3 and U12). 
The ADP2370 (U2), in turn, directly generates −3.0 V or 
connects to the ADP7182 to generate −2.5 V for the −VS pin of 
the amplifier. The ADM7160 (U3 and U12) provides 2.5 V for 
DVDD and VIO (U1). The user also can use external bench top 
supplies to power the on-board amplifiers. The 3.3 V supply for 
the EEPROM (U7) comes from the EVAL-SDP-CH1Z through 
a 160-pin FMC connector, J7. Each supply is decoupled where it 
enters the board and again at each device. A single ground 
plane is used on this board to minimize the effect of high 
frequency noise interference. 

 

Table 1. Pin Jumper Descriptions 
Link Default  Purpose 
JP1, JP2 B to center Connects analog inputs VIN+ and VIN− to the inputs of the ADC driver ADA4899-1, ADA4897-1, or AD8021. The 

A to center position sets the fully differential path through the AD8139.  
JP3, JP4 B to center Connects the outputs from the ADA4899-1 to the inputs of the ADC. The A to center position sets the fully 

differential path. 
JP5 A to center Connects the VCM output from the ADR4550 to the VCM buffer AD8031. 
JP6 B to center Connects 2.5 V to the ADC AVDD (analog core) supply. To prevent permanent damage to the ADC, do not 

connect this supply to supplies >2.5 V. 
JP7 ADC specific Single or differential ADC input selection. The AD7986 default position is B to center. The AD7944 and AD7985 

default position is A to center.  
JP8 B to center Connects 7.5 V to amplifier +VS. 
JP9 B to center Connects −3.0 V to amplifier −VS. 
JP10 B to center Connects 5 V to ADC BVDD. For an external reference, the best performance is obtained when the reference 

source that is connected to the REF pins and BVDD are the same. Used in conjunction with LK3. 
JP11 B to center Connects 2.5 V to ADC DVDD (digital core) supply. To prevent permanent damage to the ADC, do not connect 

this supply to supplies >2.5 V. 
JP12 B to center Connects 2.5 V to the ADC digital input/output supply. 
LK1 B Option to use external 12 V power supply or +12V_FMC power from the EVAL-SDP-CH1Z. 
LK2 REFIN to GND Selects the internal reference and/or the reference buffer. Used in conjunction with LK10 and LK3.  
LK3 Not inserted Option to connect REF with BVDD. 
LK4 B Connects to the 7.5 V supply coming from the ADP7118. 
LK5 B Connects to the −3.0 V supply coming from the ADP2370. 
LK6 B Connects the VCM to VCM buffer AD8031. 
LK7 A Connects the +5 V output from the ADR4550 to generate the REF buffer AD8031. 
LK8 A to B Connects the SDO pin of the ADC to the level shifter pin. 
LK9, LK11, 
LK12, LK13 

B to center Connect the TURBO, SDI, CNV, and SCK pins of the ADC to level shifter pins. The A to center position bypasses the 
level shifter. To prevent different voltage level damage to the ADC, the B to center position is recommended. 

LK10 A Selection of either the internal reference of the ADC or an external reference. 
LK16 B Connects −NEG with the −3.0 V supply coming from the ADP2370. The A to center position connects with ADP7182. 
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http://www.analog.com/ADP7182?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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Table 2. On-Board Connectors 
Connector Function 
J1, J2, J4, J5 SMA analog input. Connects the low noise analog signal source to the inputs of the ADC driver ADA4899-1, ADA4897-1, 

AD8021, or AD8139.  
J3 3-pin terminal. This option is for using external bench top supplies. Apply external +Vs, −Vs, and GND to power amplifiers on 

the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-AD7986FMCZ evaluation board. 
J6 6-pin (2 × 3) socket. This option is for interfacing with an external ADC driver board. 
J7 160-pin FMC 10 mm male VITA 57 connector. This connector mates with the EVAL-SDP-CH1Z board. 
J8, J9 7-pin (1 × 7) header connector. This option is for using an external ADC driver board. 
J10 6-pin (1 × 6) header connector. This option is for using an external serial interface to control the ADC. 

Table 3. On-Board Power Supplies Description 
Power 
Supply 

Voltage 
Range (V) Purpose 

+VS +5 to +7.5 The two ADP7118 devices (U10, U18) generate the necessary 5 V and 7.5 V supplies, respectively, from the 12 V 
supply coming from the EVAL-SDP-CH1Z, or from external power supply. The 7.5 V supply is recommended for 
the on-board amplifier +VS. The 5 V supply is provided to AVDD (U1), the ADP2370 (U2), the 
ADR4525/ADR4550/ADR3412 (U5, U8, and U13), and the ADM7160 (U3 and U12). The user also has the option 
to use an external bench top supply for +VS through J3. 

−VS −2 to −5 The ADP2370 generates −3.0 V or connects to the ADP7182 to generate −2.5 V for the −VS pin of the amplifier. 
The user also has the option to use an external bench top supply for −VS through J3. 

|+VS to −VS| 12 Maximum range of supply for correct operation.1 
AVDD 5 Analog supply rail (U1).2 
DVDD2, VIO 2.5 ADC supply rails.2 
 
1 Dictated by ADA4899-1 supply operation. 
2 Refer to the AD7944, AD7985, and AD7986 data sheets. 
 

 

http://www.analog.com/ADA4899-1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADA4897-1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD8021?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD8139?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADP7118?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADP2370?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADR4525?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADR4550?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADR3412?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADM7160?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADP2370?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADP7182?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADA4899-1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7986?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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SERIAL INTERFACE 
The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-
AD7986FMCZ evaluation boards use the serial interface 
connection to the EVAL-SDP-CH1Z. The EVAL-AD7944FMCZ/ 
EVAL-AD7985FMCZ/EVAL-AD7986FMCZ have two different 
data reading options: read during conversion and read during 
acquisition, both of which can operate in 3-wire and 4-wire 
serial interface modes. When using the serial interface, the 
voltage level shifter option and the external compatible serial 
interface options are supported. The serial interface requires 
five pins (SDI, SCK, SDO, TURBO, and CNV) connected 
between each ADC and the digital host.  

The EVAL-SDP-CH1Z board features include the following: 

• XILINX Spartan®-6 FPGA  
• DDR2 

• Micron MT47H32M16Hr-25E:G  
8 Mb × 16 bits × 4 Banks(512 Mb/64 Mb) 

• SRAM 
• ISSI IS61WV25616BLL-10BLI  

256 kB × 16 bits (4 Mb/512 kB)  
• 1 × 160-pin FMC-LPC connector (refer to the VITA 57 

specification) 
• Samtec ASP-134603-01 
• Up to 1080 Mbps LVDS 
• Single-ended LVCMOS 
• Power  

• Analog Devices ADSP-BF527 Blackfin® processor 
• Core performance up to 600 MHz 
• 208-ball CSP-BGA package 
• 24 MHz CLKIN oscillator 

• 32 Mb flash memory 
• Numonyx M29W320EB or Numonyx M25P32 

• SDRAM memory 
• Micron MT48LC16M16A2P-6A  

16 Mb × 16 bits (256 Mb/32 MB) 
• 2 × 120-pin small foot print connectors 

• Hirose FX8-120P-SV1(91), 120-pin header 
• Blackfin processor peripherals exposed 

• SPI 
• SPORT 
• TWI/I2C 
• GPIO 
• PPI 
• Asynchronous parallel 

 

 

 

 

ANALOG INPUTS 
The analog inputs applied to the EVAL-AD7944FMCZ/EVAL-
AD7985FMCZ/EVAL-AD7986FMCZ evaluation boards are the 
J1 and J2 SMA (push on) connectors. These inputs are buffered 
with dedicated, discrete driver amplifier circuitry (U15 and U16 
or U14), as shown in Figure 1.  

The circuit allows different configurations, input range scaling, 
filtering, the addition of a dc component, the use of a different 
op amp, and a differential amplifier and supplies. The analog 
input amplifiers are set as unity-gain buffers at the factory. The 
positive rails of the driver amplifiers (U14, U15, and U16) are 
driven from 7.5 V (from the ADP7118, U18), and the negative 
rails are driven from −3.0 V. The positive rails of the other reference 
buffers (U4 and U11) are driven from 7.5 V, and the negative 
rails are grounded; these rails can be changed as required. The 
range of possible supplies is listed in Table 3. The default 
configuration sets both U15 and U16 at midscale generated 
from a buffered reference voltage (VCM) of the ADR4550 (U5). 
The evaluation board is factory configured to provide either a 
single-ended path or a fully differential path, as described in 
Table 1. Because the AD7986 is differential, both inputs and 
amplifier circuits are used to buffer the IN+ and IN− inputs of 
the ADCs. For the AD7944 and the AD7985 evaluation boards, 
only the J2, U15, and associated circuitry are used in the path.  

For dynamic performance, an FFT test can be performed by 
applying a very low distortion source. For low frequency testing, 
use the audio precision source. Set the outputs for balanced and 
floating. Different sources can be used, though most are single-
ended and use a fixed output resistance.  

Because the evaluation board uses the amplifiers in unity gain, 
the noninverting input has a common-mode input with a series 
590 Ω resistor, which must be taken into account when directly 
connecting a source (voltage divider).  

REFERENCE OPTIONS 
The AD7944, AD7985, and AD7986 each have an internal 
4.096 V reference together with an internal buffer that can be 
used with an external reference; the devices can also use an 
external 5.0 V or 2.048 V reference directly. The EVAL-
AD7944FMCZ/ EVAL-AD7985FMCZ/EVAL-AD7986FMCZ 
evaluation boards can be configured to use any of these 
references. The jumpers and linkers used to set the reference are 
shown in Table 1. 

External Reference: Default Configuration 

The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-
AD7986FMCZ evaluation boards include an external 5 V and 
2.048 V reference. This reference can drive the ADCs and the 
REF pin directly, or it can be buffered with the AD8031; the 
factory default setting is 5 V and buffered with the AD8031. 
The best attainable signal-to-noise ratio (SNR) is achieved by 
using the maximum reference voltage of 5 V. Refer to the 
AD7944, AD7985, and AD7986 data sheets for more details. 

http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADSP-BF527?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADP7118?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/ADR4550?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7986?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7986?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7944FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD8031?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD8031?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7986?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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Internal 4.096 V Reference 

The AD7944/AD7985/AD7986 ADCs have an internal 4.096 V 
precision reference that can be used on most applications. 
Connecting PDREF to GND enables the internal reference. When 
the internal reference is enabled, a 4.096 V as well as a 1.2 V band 
gap are present on the ADC REF pin and test point. When using 
this method, R14 and R17 must be removed to achieve the best 
performance. External sources must not be connected to these 
test points because they are directly connected to the ADC pins. 

Internal Reference Buffer 

The internal reference buffer is useful when using an external 1.2 V 
reference. When using the internal reference buffer, applying 1.2 V 
reference ADR3412 (U13) to REFIN, which is directly connected 
to the REFIN pin of the ADC, produces 4.096 V at the REF pin of 
the ADC. R14 and R17 must be removed to achieve the best 
performance. External sources must not be connected to these 
test points because they are directly connected to the ADC pins. 

LAYOUT GUIDELINES 
When laying out the printed circuit board (PCB) for the ADC, 
follow these recommended guidelines to obtain the maximum 
performance from the converter. 

• Solder the ADC exposed paddle (Pin 21) directly to the 
PCB, and connect the paddle to the ground plane of the 
board using multiple vias.  

• Decouple all the power supply pins (AVDD, BVDD, and 
VIO) and the REF pin with low ESR and low ESL ceramic 
capacitors, typically 10 µF and 100 nF, placed close to the 
DUT (U1) and connected using short, wide traces. This 
provides low impedance paths and reduces the effect of 
glitches on the power supply lines. 

• The ADC voltage reference inputs (REF) have a dynamic 
input impedance and must be decoupled with minimal 
parasitic inductances, by placing the reference decoupling 
ceramic capacitor close to, ideally right up against, the REF 
and REFGND pins and connecting them with wide, low 
impedance traces. 

• Separate analog and digital sections and keep power supply 
circuitry away from the ADC. 

• Avoid running digital lines under the device as well as 
crossover of digital and analog signals, because these 
couple noise into the ADC. 

• Do not run fast switching signals, such as CNV or clocks, 
near analog signal paths. 

• Remove the ground and power plane beneath the input 
(including feedback) and output pins of the amplifiers (U14, 
U15, and U16), because they create an undesired capacitor. 

BASIC HARDWARE SETUP 
The EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-
AD7986FMCZ evaluation boards connect to the (EVAL-SDP-
CH1Z) system demonstration board. The EVAL-SDP-CH1Z 
board is the controller board, which is the communication link 
between the PC and the main evaluation board. 

Figure 1 shows a photograph of the connections between the 
EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-
AD7986FMCZ daughter board and the EVAL-SDP-CH1Z 
controller board.  

1. Install the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/ 
EVAL-AD7986FMCZ software. Ensure that the EVAL-
SDP-CH1Z board is disconnected from the USB port of 
the PC while installing the software. The PC must be 
restarted after the installation. 

2. Before connecting power, connect the 160-pin FMC 
connector, J7, of the evaluation board to the J4 connector 
on the EVAL-SDP-CH1Z board. Nylon screws are included 
in the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/EVAL-
AD7986FMCZ evaluation kit and can be used to ensure 
the that the evaluation board and the EVAL-SDP-CH1Z 
board are connected firmly together. 

3. Connect the 12 V power supply adapter included in the kit 
to the EVAL-SDP-CH1Z. 

4. Connect the EVAL-SDP-CH1Z board to the PC via the 
USB cable. Windows XP users may need to search for the 
EVAL-SDP-CH1Z drivers. Choose to automatically search 
for the drivers for the EVAL-SDP-CH1Z board if prompted 
by the operating system. 

5. Launch the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/ 
EVAL-AD7986FMCZ software from the Analog Devices 
subfolder in the Programs menu. The full software 
installation procedure is described in the Evaluation Board 
Software section. 
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EVALUATION BOARD SOFTWARE 
SOFTWARE INSTALLATION 
The AD7944/AD7985/AD7986 evaluation software is available to 
download from the EVAL-AD7944FMCZ/EVAL-AD7985FMCZ/ 
EVAL-AD7986FMCZ product pages. Double-click the setup.exe 
file to run the install. The default location for the software is 
C:\Program Files (x86)\Analog Devices\AD7944_85_86 
Evaluation Software. 

Install the evaluation software before connecting the evaluation 
board and EVAL-SDP-CH1Z board to the USB port of the PC 
to ensure that the evaluation system is correctly recognized when 
connected to the PC. 

There are two parts of the software installation process: 

 AD7944/AD7985/AD7986 evaluation software installation 
 EVAL-SDP-CH1Z board driver installation 

Figure 3 to Figure 9 show the separate steps to install the AD7944/ 
AD7985/AD7986 evaluation software, and Figure 10 to Figure 15 
show the separate steps to install the EVAL-SDP-CH1Z drivers. 
Proceed through all of the installation steps to install the software 
and drivers in the appropriate locations.  

Connect the EVAL-SDP-CH1Z board to the PC only after the 
software and drivers have been installed. 
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Figure 3. User Account Control 

12
47

6-
00

4

 
Figure 4. Evaluation Software Installation—Initializing 
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Figure 5. Evaluation Software Installation—Choose Install Location 
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Figure 6. Evaluation Software Installation—License Agreement 
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Figure 7. Evaluation Software Installation—Summary 

http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7986?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/eval-sdp-h1?doc=ug-727.pdf
http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7944?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7986?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/EVAL-SDP-H1?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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Figure 8. Evaluation Software Installation—In Progress 
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Figure 9. Evaluation Software Installation—Complete 
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Figure 10. EVAL-SDP-CH1Z Drivers Setup—Welcome 
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Figure 11. EVAL-SDP-CH1Z Drivers Setup—Choose Install Location 
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Figure 12. EVAL-SDP-CH1Z Drivers Setup—Installing Drivers 
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Figure 13. EVAL-SDP-CH1Z Drivers Setup—Windows Security 
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Figure 14. EVAL-SDP-CH1Z Drivers Setup—Installation Complete 
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Figure 15. Restart Required 

After installation is complete, connect the EVAL-AD7944FMCZ, 
the EVAL-AD7985FMCZ, or the EVAL-AD7986FMCZ to the 
EVAL-SDP-CH1Z board, as described in the Evaluation Board 
Hardware section. 

When you first plug in the EVAL-SDP-CH1Z board via the USB 
cable provided, allow the new Found Hardware Wizard to run. 
Once the drivers are installed, check that the board has connected 
correctly by looking at the Device Manager of the PC. The Device 
Manager can be accessed via My Computer > Manage > Device 
Manager from the list of System Tools. The EVAL-SDP-CH1Z 
board appears under ADI Development Tools, which indicates 
that the installation is complete. 
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Figure 16. Device Manager 

LAUNCHING THE SOFTWARE 
Once the evaluation board and the EVAL-SDP-CH1Z board are 
correctly connected to your PC, the AD7944/AD7985/AD7986 
evaluation software can be launched.  

1. From the Start menu, click Programs > Analog Devices > 
AD7944_85_86 Evaluation Software. The main window 
of the software appears (see Figure 19).  
a. If the evaluation system is not connected to the USB 

port via the EVAL-SDP-CH1Z when the software is 
launched, a connectivity error displays (see Figure 17).  

b. Connect the evaluation board to the USB port of the PC.  
c. Wait for a few seconds and then click Rescan (see 

Figure 18). 
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Figure 17. Connectivity Error Alert 1 
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Figure 18. Connectivity Error Alert 2 
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SOFTWARE OPERATION 
This section describes the full software operation and all the 
windows that appear. When the software is launched, the main 
software window opens, and the software searches for hardware 
connected to the PC. The user software window launches as 
shown in Figure 19. The labels listed in this section correspond 
to the numbered labels in Figure 19. 

File Menu  

The File menu, Label 1 in Figure 19, has the following options: 

• Save Captured Data: saves data to a .CSV file 
• Load Captured Data: loads data for analysis 
• Take Screenshot: saves the current screen 
• Print: prints the window to the default printer 
• Exit: closes the application 

Edit Menu  

The Edit menu, Label 2 in Figure 19, provides the Initialize to 
Default Values option, which resets the software to its initial state. 

Help Menu  

The Help menu, Label 3 in Figure 19, offers help from the 

• Analog Devices website 
• User Guide 
• Context Help 
• About  

Eval Board Connected  

This indicator, Label 4 in Figure 19, shows that the evaluation 
board is connected. In Figure 19, the connected evaluation 
board is the EVAL-AD7985FMCZ.  

Samples  

From the Samples drop-down menu, Label 5 in Figure 19, 
select the number of samples to analyze when running the 
software; this number is limited to 1,048,576 samples. 

Single Capture and Continuous Capture 

Clicking Single Capture , Label 6 in Figure 19, performs a 
single capture, whereas clicking Continuous Capture, Label 7 
in Figure 19, performs a continuous capture from the ADC.  

Interface Selection 

The Interface Selection drop-down menu, Label 8 in Figure 19, 
provides options for using 3-wire or 4-wire mode, reading 
during or reading after conversion, and no busy signal mode.  

Voltage Reference 

The options for using the external reference or internal reference 
are controlled by the Voltage Reference drop-down menu, 
Label 9 in Figure 19. The default value is set to 5 V (external 
reference and external buffer). The other voltage reference 
options are 4.096 V (external or internal reference) and 2.048 V 
(external reference). When using the external reference, it is 
recommended to use an on-board AD8031 as an external 
reference buffer. 

Turbo Mode 

The Turbo Mode button, Label 10 in Figure 19, provides the 
options of Turbo On or Turbo Off (normal mode). Note that 
the throughput must be manually changed when changing modes. 

Throughput  

The Through Output field, Label 11 in Figure 19, controls the 
throughput. The default throughput (sampling frequency) is 
2000 kSPS. The user can adjust the sampling frequency; however 
there are limitations around the sample frequency related to the 
SCLK frequency applied. The sample frequency must be at least 
200 kSPS. The AD7985 is capable of operating a maximum sample 
frequency of 2500 kSPS in reading during conversion turbo mode. 

If the user enters a value exceeding the maximum capacity of 
the device, the software indicates this, and the user must revert 
to the maximum sample frequency. 

Tabs 

There are four additional tabs available for displaying the data 
in different formats.  

• Waveform  
• Histogram 
• FFT 
• Summary 

To exit the software, go to File > Exit. 

 

 

http://www.analog.com/EVAL-AD7985FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD8031?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
http://www.analog.com/AD7985?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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Figure 19. Evaluation Software Window 
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WAVEFORM CAPTURE 
Figure 20 shows the Waveform tab. A 20 kHz sine wave input 
signal was used along with an on-board 5 V external reference.  

The Waveform Analysis boxes, Label 1 in Figure 20, show the 
amplitudes recorded from the captured signal in addition to the 
frequency of the signal tone.  
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Figure 20. Waveform Capture Tab 
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DC TESTING—HISTOGRAM 
Figure 21 shows the Histogram tab. The histogram can be used 
to test the ADC for the code distribution for dc input, compute 
the mean and standard deviation or transition noise of the 
converter, and display the results. Raw data is captured and 
passed to the PC for statistical computations.  

To perform a histogram test, click the Histogram tab, then click 
Single Capture or Continuous Capture. 

A histogram test can be performed without an external source 
because the evaluation board has a buffered VREF/2 source at the 
ADC input.  

To test other dc values, apply a source to the J1 and J2 inputs. 
The signal may need to be filtered so that the dc source noise is 
compatible with that of the ADC.  

AC TESTING—HISTOGRAM 
The histogram can also be used to test the ADC for the code 
distribution for ac input, compute the mean and standard deviation 
or transition noise of the converter, and display the results. Raw 
data is captured and passed to the PC for statistical computations.  

To perform a histogram test, click the Histogram tab, then click 
Single Capture or Continuous Capture. 

An ac histogram requires a quality signal source applied to the 
input J1/J2 connectors.  

Figure 21 shows the histogram for a 20 kHz sine wave applied to 
the ADC input and the results calculated. 

The Histogram Analysis boxes, Label 1 in Figure 21, show the 
various measured values for the data captured.  
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Figure 21. Histogram Capture Tab 
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AC TESTING—FFT CAPTURE  
Figure 22 shows the FFT tab. This tests the traditional ac 
characteristics of the converter and displays a fast Fourier 
transform (FFT) of the results. As in the histogram test, raw 
data is captured and passed to the PC where the FFT is performed 
to display the signal-to-noise ratio (SNR), signal-to-noise-and-
distortion ratio (SINAD), total harmonic distortion (THD), 
and spurious-free dynamic range (SFDR).  

To perform an ac test, apply a sinusoidal signal to the evaluation 
board at the SMA inputs, J1 and J2. A very low distortion, better 
than 130 dB input signal source (such as audio precision) is 
required to allow true evaluation of the device. One possibility 

is to filter the input signal from the ac source. There is no 
suggested band-pass filter, but carefully consider the choices. 
Furthermore, if using a low frequency band-pass filter when the 
full-scale input range is more than a few volts peak-to-peak, it is 
recommended to use the on-board amplifiers to amplify the signal, 
thus preventing the filter from distorting the input signal.  

Figure 22 displays the results of the captured data.  

FFT Analysis shows the input signal information (Label 1), as 
well as the performance data, including SNR, dynamic range, THD, 
SINAD, and noise performance (Label 3). 

Show Harmonic Content displays the fundamental frequency and 
amplitude in addition to the second to fifth harmonics (Label 2). 
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Figure 22. FFT Capture Tab 
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SUMMARY TAB 
Figure 23 shows the Summary tab, which captures all the display information and provides it in one tab with a synopsis of the information, 
including key performance parameters such as SNR and THD. 
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Figure 23. Summary Tab 
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TROUBLESHOOTING 
This section provides recommendations on how to prevent and 
troubleshoot problems encountered with the software and the 
hardware. 

SOFTWARE 
Follow these recommendations for the evaluation software: 

• Always install the software prior to connecting the 
hardware to the PC. 

• Always allow the install to fully complete (the software 
installation is a two part process: installing the ADC software 
and the SDP drivers). This may require a restart of the PC. 

• When you first plug in the EVAL-SDP-CH1Z board via the 
USB cable provided, allow the new Found Hardware Wizard 
to run. Though this may take time, do this prior to starting 
the software. 

• If the board does not appear to be functioning, ensure that the 
ADC evaluation board is connected to the EVAL-SDP-CH1Z 
board and that the SDP board is recognized in the Device 
Manager, as shown in Figure 16. 

• If connected to a slower USB port where the EVAL-SDP-
CH1Z cannot read quickly, a timeout error may occur. In 
this case, it is advised not to read continuously or, alternatively, 
to lower the number of samples taken. 

• Note that when reading continuously from the ADC, the 
recommended number of samples is up to 1,048,576. 

HARDWARE 
If the software does not read any data back, take the following steps: 

• With the 12 V wall wart plugged in to the EVAL-SDP-CH1Z 
board, check that the voltage applied is within the ranges 
shown in Table 3. 

• Using a digital multimeter (DMM), measure the voltage 
present at 12 V and the VADJ test points, which should 
read 12 V and 2.5 V, respectively. The +12V_FMC LED of 
the evaluation board and the LEDs of the EVAL-SDP-CH1Z 
board (FMC_PWR_GO, SYS_PWR, FPGA_DONE, 
BF_POWER, LED0, and LED2) should all be lit.  

• Launch the software and read the data. If nothing happens, 
exit the software. 

• Remove the 12 V wall wart and USB from the EVAL-SDP-
CH1Z board, and then reconnect them and relaunch the 
software. 

• If an error occurs, check that the evaluation board and the 
EVAL-SDP-CH1Z board are connected together so that the 
EVAL-SDP-CH1Z is recognized in the Device Manager, as 
shown in Figure 16. 

Note that when working with the software in standalone/offline 
mode (no hardware connected), if you later choose to connect 
hardware, first close and then relaunch the software. 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 
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Figure 24. Schematic—System Power Supply Options 
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Figure 25. Schematic—Op Amp and ADC Power Supply Options 
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Figure 26. Schematic—External Reference 
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Figure 27. Schematic—Analog Front End 
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Figure 28. Schematic—AD7944/AD7985/AD7986 Decoupling 
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Figure 29. Schematic—FMC-LPC Male Connector 
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Figure 30. Evaluation Board Silkscreen—Top Assembly 
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Figure 31. Evaluation Board Silkscreen—Bottom Assembly 
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Figure 32. Evaluation Board—Top Layer 
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Figure 33. Evaluation Board Layer 2—Ground 
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Figure 34. Evaluation Board Layer 3—Power 
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Figure 35. Evaluation Board Bottom Layer 
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BILL OF MATERIALS 
Table 4. Analog Bill of Materials for EVAL-AD7986FMCZ  
Reference Designator Part Description Part Number Stock Code 
+5V, +7V5, +12V, +12V_EXT, 
−3P0V, 1PT2V_REFIN, 
2PT5V_REF, 2V5_EXT, 
3P3VAUX, 5V_REF, 
BVDD_EXT, GND1 to GND3 

Test point 20-313137 Not Inserted 

PG_C2M, VADJ, VCM, 
VCM_EXTERNAL 

Test point 20-313137 Do Not Place 

+12V_SYS LED, 0603, green SML-LX0603SUGW-TR Digikey 67-1693-1-ND 
C1, C8, C11, C15, C25, C32, 
C33, C38, C39, C42, C44, 
C60, C62, C65 

Capacitor 0805ZC106KAT2A FEC 2094042 

C2, C3, C5, C7, C9, C12, 
C20, C27, C28, C31, C35, 
C40, C43, C52, C54, C56 to 
C59, C61, C75 

Capacitor, 0603 MCCA000255 FEC 1759122 

C4, C66, C77, C78 Capacitor GRM188R60J475KE19D FEC 1735527 
C6, C19 Capacitor GRM188R61A105KA61D FEC 1828798 
C10, C17, C22, C24, C26 Capacitor TBA Do Not Place 
C13, C16, C18 Capacitor GRM219R61C106KA73D FEC 1845747 
C14, C30, C34, C36, C63, 
C64, C69, C70 

Capacitor EMK212B7475KG-T FEC 2112841 

C21, C23 Capacitor EMK212B7225KG-T FEC 1683654 
C29, C37, C41, C45 to C47, 
C50, C51, C53, C55, C67, 
C68, C72 to C74, C79 

Capacitor, 0603 Not Applicable Do Not Place 

C48, C49 Capacitor, 0603 MCCA000201 FEC 1907308 
C71, C76 Capacitor, 0603 C1608C0G1H101J080AA FEC 1907297 
D1 Diode, Schottky, 40 V, 0.2 A, 1PS79SB30 1PS79SB30 FEC 8734097 
J1, J2 SMA 5-1814400-1 Not Inserted 
J3 Connector, Power 3 CTB5000/3 FEC 151790 
J4, J5 SMA 142-0701-851 Digikey J658-ND 
J6 Header, 06, SKT, RA TBA Not Inserted 
J7 ASP-134604-01 ASP-134604-01 Samtec ASP-134604-01 
J8 Connector, 7 position, header SSW-107-01-T-S FEC 1803478 
J9 Connector, 7 position, header TLW-107-05-G-S FEC 1668499 
J10 Connector, 6 position, header TLW-106-05-G-S Not Inserted 
JP1 to JP12, LK6 to LK9, LK11 
to LK14, R1, R3, R4, R10 

3 W, solder link, 0603 MC 0.063W 0603 0R FEC 9331662 

L1, L3 to L5 Bead, 0805 HZ0805E601R DigiKey 240-1018-1-ND 
L2 Inductor, 22 µH, LPS4414-223MLB LPS4414-223MLB FEC 2287727 
L6 Inductor LQH32CN1R0M33L FEC 9522174 
LK1, LK2, LK4, LK5, LK10 Jumper, 2 M20-9983646 & M7566-05 FEC 1022244 & 150-411 (36 Pin Strip) 
LK3 Jumper M20-9990246 Do Not Insert 
R2, R9, R13, R26, R44, R47, 
R49, R55, R70, R72 

Resistor Not Applicable Do Not Place 

R5 Resistor MC0063W060313K3 FEC 9331026 
R6 Resistor MC0063W0603123K7 FEC 1170924 
R7, R8, R14, R16, R17, R39, 
R45, R63 

Resistor MC 0.1W 0805 0R FEC 9333681 

R11 Resistor MC0063W0603164K9 FEC 1170968 
R12, R22 Resistor MC 0.063W 0603 1% 1K FEC 9330380 

http://www.analog.com/EVAL-AD7986FMCZ?doc=EVAL-AD7944FMCZ_AD7985FMCZ_AD7986FMCZ_UG-727.pdf
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Reference Designator Part Description Part Number Stock Code 
R15, R20, R21, R23, R24, R27 
to R29, R31 to R33, R35, R36, 
R43, R46, R48, R50, R59, R60, 
R64, R65, R67 

Resistor, 0 Ω MC 0.063W 0603 0R FEC 9331662 

R18 Resistor CRCW08055K00FKTA FEC 1835558 
R19 Resistor MCTC0525B1002T5E FEC 1575900 
R25, R30 Resistor TBA Do Not Place 
R34 Resistor MC01W08051100R FEC 9332375 
R37, R38, R40, R41 Resistor ERA6AEB5900V FEC 1810481 
R42, R51, R54, R56 Resistor ERA3AEB201V Do Not Place 
R52, R53 Resistor CPF0805B10RE1 FEC 1697403 
R57, R58 82 Ω, 0603, 1%, 0.063 W MC0063W0603182R FEC 9331590 
R61 Resistor MC0063W060311R0 FEC 2141505 
R62 18 Ω, 0805, 1%, 0.1 W MC01W0805118R FEC 9332740 
R66 Resistor MC0063W0603110K FEC 9330399 
R68 Resistor CRCW04020000Z0ED FEC 1469661 
R69 Resistor MC00625W0402111K FEC 1358070 
R71 Resistor MC00625W0402111K5 FEC 1803142 
U1 AD7986BCPZ AD7986BCPZ AD7986BCPZ 
U2 ADP2370ACPZ ADP2370ACPZ ADP2370ACPZ-R7 
U3, U12 ADM7160AUJZ-2.5 ADM7160AUJZ-2.5 ADM7160AUJZ-2.5-R2 
U4, U11, U19 AD8031ARZ AD8031ARZ AD8031ARZ 
U5 ADR4550BRZ ADR4550BRZ ADR4550BRZ 
U6 FXL2TD245 FXL2TD245L10X Digikey FXL2TD245L10XCT-ND 
U7 M24C02-WMN6TP M24C02-WMN6TP Digikey 497-8552-1-ND 
U8 ADR4525BRZ ADR4525BRZ ADR4525BRZ 
U9 FXL4TD245BQX FXL4TD245BQX Digikey FXL4TD245BQXCT-ND 
U10, U18 ADP7118ACPZN-5.0 ADP7118ACPZN-5.0 ADP7118ACPZN-5.0-R7 
U13 ADR3412ARJZ ADR3412ARJZ ADR3412ARJZ-R2 
U14 AD8139ARDZ AD8139ARDZ Do Not Place 
U15, U16 ADA4899-1 ADA4899-1YRDZ ADA4899-1YRDZ 
U17 NC7S04 NC7SZ04M5 FEC 1013809 
U20 ADP7182AUJZ ADP7182AUJZ ADP7182AUJZ-R7 
X1, X2 MTHOLE-4MM TBA Do Not Place 
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Table 5. Analog Bill of Materials for EVAL-AD7985FMCZ  
Reference Designator Part Description Part Number Stock Code 
+5V, +7V5, +12V, +12V_EXT, 
−3P0V, 1PT2V_REFIN, 
2PT5V_REF, 2V5_EXT, 
3P3VAUX, 5V_REF, 
BVDD_EXT, GND1 to GND3 

Test point 20-313137 Not Inserted 

PG_C2M, VADJ, VCM, 
VCM_EXTERNAL 

Test point 20-313137 Do Not Place 

+12V_SYS LED, 0603, green SML-LX0603SUGW-TR Digikey 67-1693-1-ND 
C1, C8, C11, C15, C25, C32, 
C33, C38, C39, C42, C44, 
C60, C62, C65 

Capacitor 0805ZC106KAT2A FEC 2094042 

C2, C3, C5, C7, C9, C10, C12, 
C20, C27, C28, C31, C35, 
C40, C43, C52, C54, C56 to 
C59, C61, C75 

Capacitor, 0603 MCCA000255 FEC 1759122 

C4, C66, C77, C78 Capacitor GRM188R60J475KE19D FEC 1735527 
C6, C19 Capacitor GRM188R61A105KA61D FEC 1828798 
C17, C22, C24, C26 Capacitor TBA Do Not Place 
C13, C16, C18 Capacitor GRM219R61C106KA73D FEC 1845747 
C14, C30, C34, C36, C63, 
C64, C69, C70 

Capacitor EMK212B7475KG-T FEC 2112841 

C21, C23 Capacitor EMK212B7225KG-T FEC 1683654 
C29, C37, C41, C45 to C47, 
C50, C51, C53, C55, C67, 
C68, C72 to C74, C79 

Capacitor, 0603 Not Applicable Do Not Place 

C48, C49 Capacitor, 0603 MCCA000201 FEC 1907308 
C71, C76 Capacitor, 0603 C1608C0G1H101J080AA FEC 1907297 
D1 Diode, Schottky, 40 V, 0.2 A, 1PS79SB30 1PS79SB30 FEC 8734097 
J1, J2 SMA 5-1814400-1 Not Inserted 
J3 Connector, Power 3 CTB5000/3 FEC 151790 
J4, J5 SMA 142-0701-851 Digikey J658-ND 
J6 Header, 06, SKT, RA TBA Not Inserted 
J7 ASP-134604-01 ASP-134604-01 Samtec ASP-134604-01 
J8 Connector, 7 position, header SSW-107-01-T-S FEC 1803478 
J9 Connector, 7 position, header TLW-107-05-G-S FEC 1668499 
J10 Connector, 6 position, header TLW-106-05-G-S Not Inserted 
JP1 to JP12, LK6 to LK9, LK11 
to LK14, R1, R3, R4, R10 

3 W, solder link, 0603 MC 0.063W 0603 0R FEC 9331662 

L1, L3 to L5 Bead, 0805 HZ0805E601R DigiKey 240-1018-1-ND 
L2 Inductor, 22 µH, LPS4414-223MLB LPS4414-223MLB FEC 2287727 
L6 Inductor LQH32CN1R0M33L FEC 9522174 
LK1, LK2, LK4, LK5, LK10 Jumper, 2 M20-9983646 & M7566-05 FEC 1022244 & 150-411 (36 Pin Strip) 
LK3 Jumper M20-9990246 Do Not Insert 
R2, R9, R13, R26, R42 to 
R44, R47, R49 to R51, R54, 
R55, R56, R70, R72 

Resistor Not Applicable Do Not Place 

R5 Resistor MC0063W060313K3 FEC 9331026 
R6 Resistor MC0063W0603123K7 FEC 1170924 
R7, R8, R14, R16, R17, R39, 
R45, R63 

Resistor MC 0.1W 0805 0R FEC 9333681 

R11 Resistor MC0063W0603164K9 FEC 1170968 
R12, R22 Resistor MC 0.063W 0603 1% 1K FEC 9330380 
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Reference Designator Part Description Part Number Stock Code 
R15, R20, R21, R23, R24, 
R27 to R29, R31 to R33, 
R35, R36, R46, R48, R59, 
R60, R64, R65, R67 

Resistor, 0 Ω MC 0.063W 0603 0R FEC 9331662 

R18 Resistor CRCW08055K00FKTA FEC 1835558 
R19 Resistor MCTC0525B1002T5E FEC 1575900 
R25, R30 Resistor TBA Do Not Place 
R34 Resistor MC01W08051100R FEC 9332375 
R37, R38, R40, R41 Resistor ERA6AEB5900V FEC 1810481 
R52, R53 Resistor CPF0805B10RE1 FEC 1697403 
R57, R58 82 Ω, 0603, 1%, 0.063 W MC0063W0603182R FEC 9331590 
R61 Resistor MC0063W060311R0 FEC 2141505 
R62 18 Ω, 0805, 1%, 0.1 W MC01W0805118R FEC 9332740 
R66 Resistor MC0063W0603110K FEC 9330399 
R68 Resistor CRCW04020000Z0ED FEC 1469661 
R69 Resistor MC00625W0402111K FEC 1358070 
R71 Resistor MC00625W0402111K5 FEC 1803142 
U1 AD7985BCPZ AD7985BCPZ AD7985BCPZ 
U2 ADP2370ACPZ ADP2370ACPZ ADP2370ACPZ-R7 
U3, U12 ADM7160AUJZ-2.5 ADM7160AUJZ-2.5 ADM7160AUJZ-2.5-R2 
U4, U11, U19 AD8031ARZ AD8031ARZ AD8031ARZ 
U5 ADR4550BRZ ADR4550BRZ ADR4550BRZ 
U6 FXL2TD245 FXL2TD245L10X Digikey FXL2TD245L10XCT-ND 
U7 M24C02-WMN6TP M24C02-WMN6TP Digikey 497-8552-1-ND 
U8 ADR4525BRZ ADR4525BRZ ADR4525BRZ 
U9 FXL4TD245BQX FXL4TD245BQX Digikey FXL4TD245BQXCT-ND 
U10, U18 ADP7118ACPZN-5.0 ADP7118ACPZN-5.0 ADP7118ACPZN-5.0-R7 
U13 ADR3412ARJZ ADR3412ARJZ ADR3412ARJZ-R2 
U14 AD8139ARDZ AD8139ARDZ Do Not Place 
U15, U16 ADA4899-1 ADA4899-1YRDZ ADA4899-1YRDZ 
U17 NC7S04 NC7SZ04M5 FEC 1013809 
U20 ADP7182AUJZ ADP7182AUJZ ADP7182AUJZ-R7 
X1, X2 MTHOLE-4MM TBA Do Not Place 
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Table 6. Analog Bill of Materials for EVAL-AD7944FMCZ  
Reference Designator Part Description Part Number Stock Code 
+5V, +7V5, +12V, +12V_EXT, 
−3P0V, 1PT2V_REFIN, 
2PT5V_REF, 2V5_EXT, 
3P3VAUX, 5V_REF, 
BVDD_EXT, GND1 to GND3 

Test point 20-313137 Not Inserted 

PG_C2M, VADJ, VCM, 
VCM_EXTERNAL 

Test point 20-313137 Do Not Place 

+12V_SYS LED, 0603, green SML-LX0603SUGW-TR Digikey 67-1693-1-ND 
C1, C8, C11, C15, C25, C32, 
C33, C38, C39, C42, C44, 
C60, C62, C65 

Capacitor 0805ZC106KAT2A FEC 2094042 

C2, C3, C5, C7, C9, C10, 
C12, C20, C27, C28, C31, 
C35, C40, C43, C52, C54, 
C56 to C59, C61, C75 

Capacitor, 0603 MCCA000255 FEC 1759122 

C4, C66, C77, C78 Capacitor GRM188R60J475KE19D FEC 1735527 
C6, C19 Capacitor GRM188R61A105KA61D FEC 1828798 
C17, C22, C24, C26 Capacitor TBA Do Not Place 
C13, C16, C18 Capacitor GRM219R61C106KA73D FEC 1845747 
C14, C30, C34, C36, C63, 
C64, C69, C70 

Capacitor EMK212B7475KG-T FEC 2112841 

C21, C23 Capacitor EMK212B7225KG-T FEC 1683654 
C29, C37, C41, C45 to C47, 
C50, C51, C53, C55, C67, 
C68, C72 to C74, C79 

Capacitor, 0603 Not Applicable Do Not Place 

C48, C49 Capacitor, 0603 MCCA000201 FEC 1907308 
C71, C76 Capacitor, 0603 C1608C0G1H101J080AA FEC 1907297 
D1 Diode, Schottky, 40 V, 0.2 A, 1PS79SB30 1PS79SB30 FEC 8734097 
J1, J2 SMA 5-1814400-1 Not Inserted 
J3 Connector, Power 3 CTB5000/3 FEC 151790 
J4, J5 SMA 142-0701-851 Digikey J658-ND 
J6 Header, 06, SKT, RA TBA Not Inserted 
J7 ASP-134604-01 ASP-134604-01 Samtec ASP-134604-01 
J8 Connector, 7 position, header SSW-107-01-T-S FEC 1803478 
J9 Connector, 7 position, header TLW-107-05-G-S FEC 1668499 
J10 Connector, 6 position, header TLW-106-05-G-S Not Inserted 
JP1 to JP12, LK6 to LK9, LK11 
to LK14, R1, R3, R4, R10 

3 W, solder link, 0603 MC 0.063W 0603 0R FEC 9331662 

L1, L3 to L5 Bead, 0805 HZ0805E601R DigiKey 240-1018-1-ND 
L2 Inductor, 22 µH, LPS4414-223MLB LPS4414-223MLB FEC 2287727 
L6 Inductor LQH32CN1R0M33L FEC 9522174 
LK1, LK2, LK4, LK5, LK10 Jumper, 2 M20-9983646 & M7566-05 FEC 1022244 & 150-411 (36 Pin Strip) 
LK3 Jumper M20-9990246 Do Not Insert 
R2, R9, R13, R26, R42 to 
R44, R47, R49 to R51, R54, 
R55, R56, R70, R72 

Resistor Not Applicable Do Not Place 

R5 Resistor MC0063W060313K3 FEC 9331026 
R6 Resistor MC0063W0603123K7 FEC 1170924 
R7, R8, R14, R16, R17, R39, 
R45, R63 

Resistor MC 0.1W 0805 0R FEC 9333681 

R11 Resistor MC0063W0603164K9 FEC 1170968 
R12, R22 Resistor MC 0.063W 0603 1% 1K FEC 9330380 
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Reference Designator Part Description Part Number Stock Code 
R15, R20, R21, R23, R24, 
R27 to R29, R31 to R33, 
R35, R36, R46, R48, R59, 
R60, R64, R65, R67 

Resistor, 0 Ω MC 0.063W 0603 0R FEC 9331662 

R18 Resistor CRCW08055K00FKTA FEC 1835558 
R19 Resistor MCTC0525B1002T5E FEC 1575900 
R25, R30 Resistor TBA Do Not Place 
R34 Resistor MC01W08051100R FEC 9332375 
R37, R38, R40, R41 Resistor ERA6AEB5900V FEC 1810481 
R52, R53 Resistor CPF0805B10RE1 FEC 1697403 
R57, R58 82 Ω, 0603, 1%, 0.063 W MC0063W0603182R FEC 9331590 
R61 Resistor MC0063W060311R0 FEC 2141505 
R62 18 Ω, 0805, 1%, 0.1 W MC01W0805118R FEC 9332740 
R66 Resistor MC0063W0603110K FEC 9330399 
R68 Resistor CRCW04020000Z0ED FEC 1469661 
R69 Resistor MC00625W0402111K FEC 1358070 
R71 Resistor MC00625W0402111K5 FEC 1803142 
U1 AD7944BCPZ AD7944BCPZ AD7944BCPZ 
U2 ADP2370ACPZ ADP2370ACPZ ADP2370ACPZ-R7 
U3, U12 ADM7160AUJZ-2.5 ADM7160AUJZ-2.5 ADM7160AUJZ-2.5-R2 
U4, U11, U19 AD8031ARZ AD8031ARZ AD8031ARZ 
U5 ADR4550BRZ ADR4550BRZ ADR4550BRZ 
U6 FXL2TD245 FXL2TD245L10X Digikey FXL2TD245L10XCT-ND 
U7 M24C02-WMN6TP M24C02-WMN6TP Digikey 497-8552-1-ND 
U8 ADR4525BRZ ADR4525BRZ ADR4525BRZ 
U9 FXL4TD245BQX FXL4TD245BQX Digikey FXL4TD245BQXCT-ND 
U10, U18 ADP7118ACPZN-5.0 ADP7118ACPZN-5.0 ADP7118ACPZN-5.0-R7 
U13 ADR3412ARJZ ADR3412ARJZ ADR3412ARJZ-R2 
U14 AD8139ARDZ AD8139ARDZ Do Not Place 
U15, U16 ADA4899-1 ADA4899-1YRDZ ADA4899-1YRDZ 
U17 NC7S04 NC7SZ04M5 FEC 1013809 
U20 ADP7182AUJZ ADP7182AUJZ ADP7182AUJZ-R7 
X1, X2 MTHOLE-4MM TBA Do Not Place 
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NOTES 
 

 

 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice 
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED 
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL 
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF 
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE 
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable 
United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of 
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby 
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed. 
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